
Kramer Electronics, Ltd. 
 
 

 
 

 
 

 

RC Configuration and 
Installation Guide 

Revision 8 
 

 
Intended for Kramer Technical Personnel or external 

System Integrators. To check that you have the latest 

version, go to the DOWNLOADS section of our Web site at:  

http://www.kramerelectronics.com/support/downloads.asp  

 
  

 

http://www.kramerelectronics.com/support/downloads.asp�


Contents 

 

i 

Contents 

1 Introduction 1 
1.1 Quick Start 2 
2 Overview 3 
2.1 Requirements for Using the Kramer RC Configuration 4 
2.1.1 System Requirements 4 
2.1.2 The Required Operating System 4 
3 Initial Planning 5 
4 The RC Configuration Software 6 
4.1 Installing the Software 6 
5 Downloading and Installing the Drivers via the Driver Manager Window 8 
5.1 Download the Drivers 8 
5.2 Install the Drivers 8 
6 Connecting to the RC Device 13 
6.1 The “Discover” Connection Method 13 
6.2 The “Connect” Connection Method 14 
6.3 Changing the Network Settings 15 
7 Creating a Driver Command 16 
7.1 Creating a Serial Command 16 
7.2 Creating an IR Command 17 
7.2.1 Write the IR Commands via the IR Learner 17 
7.2.2 Connect the RC Device to your PC 19 
7.2.3 Read the IR Commands from the RC Device to the PC 20 
8 Port Mapping 21 
9 The Kramer RC Configuration Main Window 24 
10 Creating a Macro 27 
10.1 Labeling the Buttons 30 
10.2 Adding Commands to the Macro 31 
10.2.1 A Relay Command – Turn Lights ON 31 
10.2.2 The Driver Command – Switch a DVD Player to the Projector 32 
10.2.3 The IR Command –Audio Follows Video in a Matrix Switcher 34 
10.2.4 The Self Command 35 
10.3 Connecting via the ETHERNET 37 
10.3.1 Connecting the ETHERNET Port Directly to a PC (Crossover Cable) 37 
10.3.2 Connecting the ETHERNET Port via a Network Hub (Straight-Through Cable) 40 
11 The Kramer RC Configuration Menus 41 
11.1 The File Menu 41 
11.2 The Edit Menu 41 
11.3 The Configuration Menu 42 
11.4 The Device Menu 42 



KRAMER:  SIMPLE CREATIVE TECHNOLOGY 

Contents 

 ii 

11.4.1 The Discover Command 43 
11.5 The Help Menu 44 
12 Assigning the Macros to the RC Device 45 
12.1 Saving a Configuration 45 
12.2 Writing a Configuration to the RC Device 45 
13 Installation of the RC System 46 
13.1 Connecting the RS-232 Port 46 
13.2 Connecting the RS-485 Port 47 
13.3 Connecting the Relays 47 
13.4 Connecting the IR Emitter 48 
13.5 Inserting the Button Labels 48 
14 Ethernet Flash Memory Upgrade 48 
14.1 Uploading the Applet 49 
15 The UDP Protocol 50 

Figures 

Figure 1: Media Room Components List   5
Figure 2: Driver Data Base Notice   7
Figure 3: Setting a Working Directory   7
Figure 4: The Driver Manager Window Prior to Installing the Drivers   9
Figure 5: Importing a Kramer Driver File   9
Figure 6: Exporting a Kramer Driver File   10
Figure 7: The Driver Manager Window   11
Figure 8: Connecting a Device to your PC – Device Selection Dialog Box   13
Figure 9: The Connection Method – via the Ethernet   14
Figure 10: The Connection Method – via the Serial Port   14
Figure 11: Kramer RC Configuration – Set Device Details Dialog Box   15
Figure 12: New Serial Command Window   16
Figure 13: Writing the Serial Commands   16
Figure 14: Initializing the IR Learner Procedure   18
Figure 15: New IR Command Window   20
Figure 16: Creating the IR Commands   20
Figure 17: The IR Command Area   20
Figure 18: The Kramer VP-724xl in the RC Command Area   21
Figure 19: The Port Manager Window   22
Figure 20: Setting the Default Driver   22
Figure 21: Updating the Port Default Driver   23
Figure 22: Updated Port Manager Window   23
Figure 23: The Kramer RC Configuration Main Window   24
Figure 24: Event Macros Tab   27
Figure 25: Using the Toggle 1-2-3-4 Behavior   27
Figure 26: Selecting a Button to Write a Macro   28
Figure 27: Creating a New Command   28
Figure 28: Selecting the Port   29



Contents 

 

iii 

Figure 29: Setting the Delay Time and Button Lighting   29
Figure 30: Labeling the RC Buttons   30
Figure 31: Typing the Label   30
Figure 32: Lights ON RC Command   31
Figure 33: Switch a DVD to the Projector Command   33
Figure 34: IR Command Setting   34
Figure 35: Self Command Front Panel Setting   35
Figure 36: Self Command Setting   36
Figure 37: Local Area Connection Properties Window   37
Figure 38: Internet Protocol (TCP/IP) Properties Window   38
Figure 39: Local Area Connection Properties Window   39
Figure 40: The Advanced Tab   39
Figure 41: Selecting Manual Link Speed   40
Figure 42: The File Menu   41
Figure 43: The Edit Menu   41
Figure 44: The Configuration Menu   42
Figure 45: The Device Menu   42
Figure 46: Device Selection Dialog box   43
Figure 47: The Help Menu   44
Figure 48: Saving a Configuration   45
Figure 49: RS-232 PINOUT Connection   46
Figure 50: RS-232 Port Wiring   46
Figure 51: RS-485 Port Wiring   47
Figure 52: Relay Wiring   47
Figure 53: IR Emitter Wiring   48
 

Tables 

Table 1: Room Controller Commands Available   3
Table 2: Driver Manager Window Features   12
Table 3: Machine Connection Method   13
Table 4: The Port Manager Window Features   22
Table 5: Kramer RC Configuration Window Features   24
Table 6: File Menu Features   41
Table 7: Edit Menu Features   41
Table 8: Configuration Menu Features   42
Table 9: Device Menu Features   42
Table 10: Device Selection Dialog Box   43
Table 11: Help Menu Features   44
Table 12: RS-232 PINOUT Connection   46
Table 13: Relay PINOUT   47



Introduction 

 

1 

1 Introduction 

Welcome to Kramer Electronics! Since 1981, Kramer Electronics has been 
providing a world of unique, creative, and affordable solutions to the vast range 
of problems that confront the video, audio, presentation, and broadcasting 
professional on a daily basis. In recent years, we have redesigned and upgraded 
most of our line, making the best even better! Our 1,000-plus different models 
now appear in 11 groups1

Congratulations on purchasing your Kramer RC device, which is ideal for 
controlling A/V equipment and media room items.  

 that are clearly defined by function. 

The software package includes the following items: 
• The program on a CD 
• This RC Configuration and Installation Guide on CD2

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

                                                        
1 GROUP 1: Distribution Amplifiers; GROUP 2: Switchers and Matrix Switchers; GROUP 3: Control Systems; GROUP 4: 

Format/Standards Converters; GROUP 5: Range Extenders and Repeaters; GROUP 6: Specialty AV Products; GROUP 7: 

Scan Converters and Scalers; GROUP 8: Cables and Connectors; GROUP 9: Room Connectivity; GROUP 10: Accessories 

and Rack Adapters; GROUP 11: Sierra Products 

2 Download up-to-date Kramer user manuals from the Internet at this URL: http://www.kramerelectronics.com 
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1.1 Quick Start 

To configure your Room Controller, follow these basic steps (see section  4): 

1. Download the software from our Web site 
at: http://www.kramerelectronics.com

2. Extract the ZIP file
3. Install the software application 

1. Check, according to your list of 
peripheral devices, that you have all the 
required drivers

2. Download the required drivers to a folder 
(for example, C:\Media-Room-
1\Peripheral Device Drivers)

1. In the Driver Manager window, select the 
required driver from the Vendor, Device 
and Revision areas 

2. Create a command via the Serial 
Command area or the IR Commands 
area

Click the “Port Manager...” Item in the 
Configuration menu and define as required
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2 Overview 

The Kramer RC devices are a series of highly sophisticated machines, used 
for controlling A/V equipment and room items in media rooms. An RC 
system includes A/V equipment (for example, DVD players, audio amplifiers 
and switchers) and media room items, such as blinds, lights and so on. Before 
operating an RC system1

• Carefully plan the installation layout 
, you have to: 

• Install the drivers of the peripheral devices  
• Configure your RC device 
• Assign the macros to the RC device 
• Install the RC system 

The RC Configuration Software V1.26.0.38 is used to configure the following 
room controller families (RC-6, RC-8, RC-7 and VP-23RC)2

 
: 

RC-6IR RC-6IRE RC-8IR RC-8IRE   
RC-6IRP RC-8IRP     
RC-8RK RC-8RKL     
RC-7B RC-7BE RC-7RL RC-7RLE RC-7LC RC-7LCE 
VP-23RC      

Since each Room Controller includes different ports3, you will find that not 
all the available commands apply to your Room Controller. 

Table 1 defines the sections that apply to each Room Controller: 

Table 1: Room Controller Commands Available 

 The Commands [Section Number] 
 

Machine  IR 
[ 10.2.3] 

RS-232 
[ 10.2.2] 

RS-485 
[ 10.2.2] 

RELAY 
[ 10.2.1] 

ETH 
[ 10.2.2] 

SELF 
[ 10.2.4] 

VP-23RC 
(internal) 
[ 10.2.2] 

RC-8IR, RC-8IRE Yes Yes Yes Yes Yes Yes  
RC-6IR, RC-6IRE Yes Yes Yes Yes Yes Yes  

RC-6IRP, RC-8IRP Yes Yes Yes Yes Yes Yes  
RC-8RK, RC-8RKL Yes Yes Yes Yes Yes Yes  

RC-7B, RC-7BE Yes Yes Yes   Yes  
RC-7LC, RC-7LCE Yes Yes Yes Yes  Yes  
RC-7RL, RC-7RLE Yes Yes Yes Yes  Yes  

VP-23RC Yes Yes  Yes Yes Yes Yes 

 

                                                        
1 An RC system includes the RC device and the peripheral devices it controls 

2 For each machine, the installation process is described in the separate user manual. you can download the up-to-date 

Kramer user manuals and guides from the Internet at this URL: http://www.kramerelectronics.com 

3 For example, RC-7B does not include relays or ETH connectors, so these commands are not available for this machine 
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2.1 Requirements for Using the Kramer RC Configuration 

This section describes the system requirements for the Kramer RC 
Configuration software. 

2.1.1 System Requirements 

The minimum system requirements include: 
• A 400MHz processor 
• 128MB RAM 
• 300MB free hard disk space 
• Microsoft Internet Explorer 6.0 
• A network connection for configuring devices 

2.1.2 The Required Operating System 

Microsoft® Windows XP® is the recommended operating system1

 
. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

                                                        
1 Windows NT does not support .NET 2.0. 
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3 Initial Planning 

Carefully plan your RC system layout to ensure a smooth and easy 
configuration, and installation. 

To do this: 
• Define your requirements 
• List the peripheral devices and room items that will be included in the 

system 
• Plan the location of each device 
• Plan the function of each device 

Make a detailed list of the functions and commands required of the system 
devices, as illustrated in the partial list in Figure 1 

 
Figure 1: Media Room Components List 

Once this list is finalized and approved, you can carry on with the 
configuration and installation process  

Note that the RC configuration and installation processes are independent of 
each other. You do not have to connect the RC device before starting the 

configuration  
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4 The RC Configuration Software 

The RC can be configured via the Kramer RC Configuration software, an 
easy-to-use software that lets you set a sequence of RC commands (the 
macro) and assign them to any of the buttons on the RC device.  

The Kramer RC Configuration software lets you: 
• Create your own device drivers manually or via the IR learner feature 
• Modify or delete commands 
• Change the order of commands within the macro 
• Set delay times between commands in a macro 
• Save multiple sets of RC device configurations 
• Read macros from the RC device 

The RC buttons can be configured prior to installation 

The following sections describe how to: 
• Install the software (see section  4.1) 
• Download the device drivers via the Driver Manager window (see section  5) 
• Create a driver command (see section  7) 
• Map the ports (see section  8) 
• Create a macro to the device (see section  10) 

4.1 Installing the Software 

Prior to using the Kramer RC Configuration software, make sure that the 
“.NET Framework”, Revision 2.0 software is installed on your PC. If it is not, 
you need to install it:  
• If you have a fast Internet connection, this software is automatically 

installed during the installation of the Kramer RC Configuration software  
• If you do not have a fast Internet connection, insert the CD-ROM into the 

CD-ROM drive, double click the dotnetfx.exe1 file and follow the 
on-screen instructions2

Before getting started with your Kramer RC Configuration, you must 
download the software and then install it. 

 

 

                                                        
1 File names are liable to change 

2 Installation may take about 15 minutes 
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You can download the Configuration program1

1. Go to our Web site at 

 from the Internet. To do so: 

http://www.kramerelectronics.com and download the 
file: “Kramer RC Config.zip” from the DOWNLOADS section. 

2. Extract the file “Kramer RC Config.zip” package, which includes the  
Kramer RC configuration application setup and the Kramer device drivers2

3. Install the Kramer RC Configuration application. 
When running Setup, you are prompted to set the working directory (see 

, to 
a folder (for example, C:\Program Files\Kramer RC Configuration). 

Figure 2): 

 
Figure 2: Driver Data Base Notice 

4. Click OK. 
The following window appears (see Figure 3): 

 
Figure 3: Setting a Working Directory 

5. Select or create a new working directory3

6. Continue to run the setup according to the installation instructions. 
. 

                                                        
1 File names are liable to change from time to time 

2 Mostly for matrix switchers and switchers 

3 The working directory will keep the information that is essential for operating the software. This information will remain 

unchanged while upgrading the software 

http://www.kramerelectronics.com/�
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5 Downloading and Installing the Drivers via the Driver 
Manager Window 

The RC system peripheral devices have device drivers that let them 
communicate with computers. The device driver needs to be installed so that 
the computer can recognize it and control it. The Kramer RC Configuration 
software uses driver commands to control these peripheral devices. 

5.1 Download the Drivers 

Check, according to the peripheral devices list (see Figure 1), that you have 
all the required drivers: 
• Kramer machines have drivers that are provided within the package 
• Other peripheral device drivers are either provided within the package, 

provided by the manufacturer or can be downloaded from the Internet 

Download the required drivers, according to the instructions provided for each 
driver, to a folder (for example, C:\Media-Room-1\Peripheral Device Drivers). 

5.2 Install the Drivers 

The peripheral device drivers are installed via the Driver Manager window, 
defined in Figure 7 and Table 2: 

To access the Driver Manager window: 
1. Open the Kramer RC Configuration program. 
2. In the File menu, click Driver Manager…1. 

The Driver Manager window appears (see Figure 4). 

Once the Driver Manager window is open, you can: 
• Import one or more drivers (Import Drivers…, see Figure 5), or export an 

existing driver (Export Driver…, see Figure 6) 
• Add a new device driver 
• Rename or delete devices, revisions and commands, as defined in Table 2 
• Set the driver revision date 
• Write new driver commands  
 

                                                        
1 If you are opening this program for the first time, the Driver Manager window appears automatically 
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Figure 4: The Driver Manager Window Prior to Installing the Drivers 

 
Figure 5: Importing a Kramer Driver File 
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Figure 6: Exporting a Kramer Driver File 
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Figure 7: The Driver Manager Window 
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Table 2: Driver Manager Window Features 

# Feature Function 
1 Vendors Area Lists the downloaded vendors  

New: press to enter a new vendor name manually 
Rename: press to rename the vendor name 
Delete: erases the selected vendor 

2 Devices Area Lists the names of devices of a selected vendor (in the Vendors area) 
New: press to enter a new device name manually 
Rename: press to rename the device name 
Delete: press to erase the selected device 

3 Revisions Area Lists the revision of a selected device 
New: press to enter a new revision manually 
Rename: press to rename the revision number 
Delete: press to erase the selected revision 

4 Driver Area Displays the selected Vendor, Device Model and Revision. Lets you set 
the Revision Date 

5 Serial Settings Area Select the serial settings for the device: the Baud Rate, the Data Bits, the 
Parity and the Stop Bits 

6 Serial Commands Area Lists the serial command names for a specific device 
New: press to enter a new command name manually 
Rename: press to rename the Command editing tab 
Delete: press to erase the selected command 

7 IR Commands Area Lists the IR command names for a specific device 
New: press to enter a new command name manually 
Rename: press to rename the Command editing tab 
Delete: erases the selected command  

8 Command Area Displays the command type or lets you manually write a new command1

9 
 

Drivers Area Import Drivers…: press to import one or more driver files 
Export Driver…: press to export a driver file 

10 OK Button Apply changes and close window 
11 Cancel Button Close window without applying changes 
12 Apply Button Apply changes, but do not close window 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
                                                        
1 See section  7.1 
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6 Connecting to the RC Device 

Table 3 defines the connecting ports available for each machine and the 
connecting methods: 

Table 3: Machine Connection Method 

The Machine Name The Connection Port The Connection Method 
RC-8IR, RC-8IRE Ethernet, RS-232 Discover (see section  6.1) 

Connect (See section  6.2) RC-6IR, RC-6IRE 
RC-6IRP, RC-8IRP 
RC-8RK, RC-8RKL 
VP-23RC 
RC-7B, RC-7BE 3.5mm Serial 

configuration Jack 
Connect (See section  6.2) 

RC-7LC, RC-7LCE 
RC-7RL, RC-7RLE 

6.1 The “Discover” Connection Method 

To connect the RC device to your PC via the Discover connection method, do 
the following: 
1. Connect the RC device to the PC via the Ethernet port, as described in section 

 10.3.  
2. Click the appropriate shortcut in the Start menu’s Programs folder.  

The Kramer RC Configuration main window opens. 
3. Open the Device menu and click Discover1

4. The Device Selection dialog box lists the devices found, and their IP number 
(see 

. 
The Device Selection window opens. 

Figure 8). Select the device and then click OK. 

 
Figure 8: Connecting a Device to your PC – Device Selection Dialog Box 

                                                        
1 To automatically search for devices 
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6.2 The “Connect” Connection Method 

To connect the RC device to your PC via the Connect connection method, do 
the following: 
1. Connect the RC device to the PC via either of the following: 
 Ethernet port (see section  10.3) 
 Serial CONFIG serial configuration jack1

2. Select the connection method to: 
 

 Ethernet (Figure 9), and enter the IP address 
 Serial Port (Figure 1 ), and enter the select the PC serial port to which 

the RC machine is connected 
0

 
Figure 9: The Connection Method – via the 

Ethernet 

 
Figure 10: The Connection Method – via 

the Serial Port 

3. Click OK. 
 
 
 
 
 
 
 
 

                                                        
1 Via the CONFIG cable (C-A35M/D9F-6) from the CONFIG port to the serial port on a PC for devices that do not have an 

Ethernet connector (for example, the RC-7BE) 
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6.3 Changing the Network Settings 

If the RC device has an Ethernet port you can change the settings according to 
your network requirements. 

To change the settings according to your network requirements: 
1. Open the Device menu and click Properties.  

The Device Properties dialog box opens.  
2. Click the Set button to apply the settings (see Figure 11). 

 
Figure 11: Kramer RC Configuration – Set Device Details Dialog Box 
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7 Creating a Driver Command 

You can write new driver commands via the Driver Manager window. You 
can write two types of commands for a device (for example, a DVD player, 
projector, A/V receiver, and so on): 
• Serial commands (see section  7.1) 
• IR commands (see section  7.2) 

7.1 Creating a Serial Command 

To write the serial commands for a selected device: 
1. Click the New button in the Serial Commands area.  

The New Serial Command window appears.  
2. Type the new command name: 

A Serial command type area appears, as illustrated in Figure 13. 

 
Figure 12: New Serial Command Window 

3. Type in the command string in the command area. 

You can test the serial commands from the driver manager, using a local serial 
port. 

 
Figure 13: Writing the Serial Commands 

The serial commands created can be sent via RS-232, RS-485 and Ethernet 
ports. 
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When writing a serial command: 

-  Enclose the strings in quotation marks (for example, "MUTE OFF") 

-  Prefix the hex characters with 0x or "$" (for example, 0x0D), unprefixed 
   values are in decimal (for example, 13) 

-  String and byte values should be separated by commas or spaces (for 
   example, "BRIGHT DEC",0x0D) 

-  If a protocol command states Carriage Return (<CR>) and/or Line Feed (<LF>) 
   following the command line, add 0x0D or 0x0A, respectively, outside the 
   command quotation marks, separated by a comma.  
   For example, “PWR” <CR> <LF> should appear as “PWR”,0x0D,0x0A 

7.2 Creating an IR Command 

In addition to installing driver IR commands, you can write new IR 
commands via the IR Learner feature. To create an IR command: 
• Write the required IR command to the RC device via its IR Learner 

function (see section  7.2.1) 
• Connect the device to your PC (see section  6) 
• Read the IR commands from the RC device to the PC 

7.2.1 Write the IR Commands via the IR Learner 

This procedure does not require that the RC device be connected to your PC, 
although it can be. 

To learn an IR command, do the following: 
1. Connect the IR device to the power source.  
2. Blot out or lower1

3. Simultaneously press and hold the two buttons (illustrated in 
 the room lighting as much as you can. 

Figure 14) for 2 
seconds. 
The buttons (as illustrated in Figure 14) on the RC device blink sequentially2

                                                        
1 Bright lights (especially fluorescent lights) may interfere with the IR learning process 

. 

2 The RC-8RK and RC-8RKL behave the same as the RC-8IRE 
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VP-23RC

RC-8IRRC-8IRP

RC-8IRE and RC-8IRKRC-6IRE

RC-7RL, RC-7LC, RC-7B

RC-6IR

 
Figure 14: Initializing the IR Learner Procedure 

4. Push the button to which you want the IR commands to be read (for example, 
button 6). 
Button 6 is now ready to accept the command.  
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5. Point the DVD’s remote control transmitter directly at the IR receiver on the 
RC device. 

6. Press the desired command on the remote control (for example, Play). 
Button 6 on the RC device is now learning the IR command.  
If the learning process is successful, button 6 on the RC device blinks several 
times, pauses, and then all the buttons blink sequentially. 
If the button did not accept the IR command (after about 10 seconds) or if an 
incorrect command was read (for example, due to some kind of interference), 
the RC device buttons blink twice simultaneously and then the device exits the 
IR Learner mode. The last command will not be registered to the button.  
To restart the IR Learner mode, repeat this procedure from step 3 onwards.  

Note that: 

• The IR learning process overwrites any previous command or macro 
on the selected button 

• Only one IR command can be written at a time, per button 

• Learned IR commands can be immediately tested by pressing the 
buttons they were learned into; an act that will send the same IR 
command over port IR1 (see note 9 below). 

7. You can continue the learning process for each button, until each button has an 
IR command, and you can also overwrite previously learned buttons.  
In this way, an IR command is transmitted to each button and then can be read 
in sequence to the driver. 

8. To exit the IR learner state, wait several seconds without pressing any button, 
until the lights cease to blink.  

9. If the peripheral device (the DVD player in this example) is connected to the 
RC device via the IR1 port, you can press the relevant button (button 63 in this 
example) to verify that the command signal has been transmitted correctly. 

7.2.2 Connect the RC Device to your PC  

After writing the IR command to button 6, connect the RC device to your PC 
to read the command data to the Kramer RC configuration program, as 
described in section  6. 
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7.2.3 Read the IR Commands from the RC Device to the PC 

To read the new IR commands from the RC device, click the New button in 
the IR commands area to type the new command name. An IR command type 
area appears, as illustrated in Figure 16.  

To write a new IR command to the RC device: 
1. Click the New button in the IR commands area to type the new command 

name. The following window appears: 

 
Figure 15: New IR Command Window 

 
Figure 16: Creating the IR Commands 

2. The button layout appears under the Command area. The button that includes 
the IR command appears red. 

3. Click the Read IR button. 
After reading the command, an “IR data successfully read” window appears. 
The IR command is now included in the selected driver file. 

Figure 17 shows the IR Command area after reading the IR command: 

  
Figure 17: The IR Command Area 
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8 Port Mapping 

The Port Manager window defines the ports on the Room Controller (see 
section  2) and lets you write a description and assign a default driver for each 
port. For example, if the Kramer VP-724xl Presentation Switcher/Scaler is 
connected to the RC-8IR via the RS-232_2 port, you can change the 
description next to that port to “Kramer Switcher” and assign the 
switcher/scaler driver to this port1

In this way, the Kramer VP-724xl driver will be associated with the Kramer 
Presentation Switcher/Scaler port

. 

2 when creating a command sequence as 
illustrated in Figure 18, making it easier to select the commands. The same 
applies to all the ports in the Port Manager window. 

  
Figure 18: The Kramer VP-724xl in the RC Command Area 

For the RS-232 and RS-485 ports on the unit, the Port Manager window also 
lets you set the baud rate, data bits, parity and stop bits. These definitions will 
override the definitions written in the driver manager. 

To open the Port Manager window, click the “Port Manager…” item in the 
Configuration menu (see section  11.3). Figure 19 shows the port manager 
window for an RC-8IR unit. 

                                                        
1 This applies also to any other machine connected to the room controller, such as DVD's projectors and so on 

2 Although you can assign it with a different Vendor or Device 
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Figure 19: The Port Manager Window 

Table 4: The Port Manager Window Features 

The Item Description 
Port Lists the number of ports available for the selected machine 
Description Type a description of the port 
Settings For serial ports, press the white area to open the serial Settings window and define the baud 

rate and parity 
For Ethernet ports, press the white area to open the Ethernet Settings window and define the 
IP address and TCP port 

Default Driver Press the white area to open the Drivers Tree window and select the default driver for this port  

 
Press to clear the Default Driver data 

Reset Press to reset to default definitions 

You can also set or update the port default driver settings in the RC Command 
area by clicking the Update button, as illustrated in Figure 20: 

 
Figure 20: Setting the Default Driver 
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After clicking the Update button, the Port default driver box displays the new 
updated port default driver, as illustrated in Figure 21: 

 
Figure 21: Updating the Port Default Driver 

The Port Manager window, illustrated in Figure 22, shows the default driver 
set for the RS485 port, as well as the default driver and description set 
previously for the RS232_2 port . 

 
Figure 22: Updated Port Manager Window 
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9 The Kramer RC Configuration Main Window 

Once the drivers are imported and the ports are defined, use the Kramer RC 
Configuration main window to assign a sequence of commands (the macro) 
for each RC button. Figure 23 illustrates the Kramer RC Configuration main 
window, and Table 5 defines it: 

 
Figure 23: The Kramer RC Configuration Main Window 

Table 5: Kramer RC Configuration Window Features 

# Feature Function 
1 Menu Bar Menus are described in section  11 
Device Area 

2 Name Box Displays the name of the specific device1

3 
  

Connection Box Displays the connection properties with the device (IP address and 
port)1 

4 Type Display Box Select the device type2

5 
.  

Change… Button Press the Change… to change the device type (from a list) 

                                                        
1 The name and IP number are initially set by the Device Selection dialog box (see section  11.4) 

2 The device type can be selected only if there is no device connected to the computer. If a device is connected, the device 

type is selected automatically 
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# Feature Function 
6 Front Panel Tab Shows the layout of the RC buttons according to the device type 

selected, with the labels on the button. Click to Select a button to 
configure, modify, read, or delete its macro.  
When the button is: 
• Blue, it is assigned a macro 
• Green, it is selected 
• Gray, it is not assigned a macro 

7 Event Macros Tab By default, two event macros are assigned and can have commands 
added to them: 
Startup – a series of commands to be executed when the machine is 
turned on 
Inactivity timeout – a series of commands to be executed after a set 
amount of inactivity time (during which no button is pressed) has 
expired (see Figure 24) 

8 Button Area1 Label Text Box  Select a button and type the required button label 
9 Behavior Drop 

Down Box 
Assign the button response to press and release actions 
Button Definition  Behavior 
Activate on Release 
(default) 

The macro is executed upon releasing the button 

Activate while 
Pressed 

The macro is activated and repeated for as 
long as the button is pressed 

Hold for 2 seconds Press and hold the button for 2 seconds to 
execute the macro  

Toggle 1-2-3-4 Cycling macro behavior: 
The button can be assigned with up to 4 
different macros. Each time it is pressed, the 
next macro in the set will be activated in a cyclic 
fashion2, provided the Automatic Advance box 
is checked (the default). If the automatic 
advance button is not checked, the macros will 
advance only as part of a macro sequence in a 
different button (see section  10.2.4) 

Toggle Press-
Release 

Dual macro behavior: 
One macro is activated when pressing the 
button and the other is activated when 
releasing the button 

Disabled The button is disabled 
10 Write Configuration Button3 Press to write the configuration of all the buttons to the device  
11 Read Configuration Button3 Press to read the configuration of all the buttons from the device 
12 Response querying Area 

(shows after checking this option 
in the configuration menu, see 
section  11.3) 

Enabled for RS-232, RS-485 and Ethernet communication 
Wait for response Check Box – check for the command to wait for a 
response before continuing with the macro 
Max. … Seconds– type the response wait timeout in seconds (from 
0 to 999 seconds) 
Check for specific response Check Box – specify an exact response 
to wait for (otherwise any response will do) 
If there is no response or the response doesn’t match, the button will 
flash and the macro will be aborted 

                                                        
1 The Button area appears only after selecting a button in the Front Panel tab 

2 The number of toggle states can be determined (from 1 to 4). The selected number of toggle states appears above the Button 

Macro area (see Figure 25) 

3 This button is enabled only when a device is connected to the PC. Otherwise it is disabled 
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# Feature Function 
Button Macro Area 

13 Button Macro Display Box Displays the macro RC commands’ Description, Delay and Port in 
sequence. Select an RC command to duplicate, delete, or change its 
position in the sequence 

 New Command Button Click to add a new command to the Button Macro display box1 (see 
section  10) 

 Duplicate Command Button Duplicate a command in the Button Macro display box 
 Delete Command Button Delete a command from the Button Macro display box 
 

 Button 
Move up the selected command 

  Button Move down the selected command 

14 RC command Area Includes the following features of the command selected in the 
Button Macro display box: 

 Description Text Box Optional descriptive text for the command 
 Port Drop Down Box Displays the port associated with the RC command: 

Select a port when modifying or writing a new RC command. 
When selecting an IR port, a serial port, or an Ethernet port, the 
Vendor, Device, Revision and Driver command drop down boxes 
appear, as well as the Port default driver box and an Update button to 
update the port default driver. The command bytes box appears for the 
serial and Ethernet ports. 
When selecting a relay port, the Relay command drop down box 
appears. 

 Vendor Drop Down Box Displays the current vendor. Select the vendor when writing a new 
RC command or modifying a selected command 

 Device Drop Down Box Displays the device driver name. Select the device driver when 
modifying or writing a new RC command 

 Revision Drop Down Box Displays the device driver revision. Select a revision when modifying 
or writing a new RC command 

 Driver command Drop Down 
Box 

Displays the current driver command. Select a driver command 
when writing a new command or modifying a selected command 

 Relay command Drop Down Box  Select the Relay command: 
Open – N.C. and Common are connected (default) 
Close – N.O. and Common are connected 

 Port default driver Box and 
Update Button 

The port default driver box shows the current port default driver. It can 
be updated by setting a different driver through the RC command and 
then clicking the Update button (see section  8) 

 Command bytes Box Displays the command bytes 
15 Button lighting Area2 Select the buttons that will illuminate, turn dark or remain the same 

following a command (the lighting configuration can be different for each 
command within the sequence). Toggle between ON (yellow), OFF 
(black) and No Change (gray). You can also click reset to reset the 
buttons to No Change (gray) 

16 Delay after command Text Box2 Set a delay time in seconds or milliseconds following the command 3

                                                        
1 The button macro display box displays <No Description> under Description and None under Port 

. 
The delay between the commands can be set from 0.01 seconds up to 
640 seconds.  Also, multiple commands with delays can be cascaded to 
create a longer delay, if required, up to about 2.5 hours (15 delays of 10 
minutes each). 

2 Shows after checking this option in the configuration menu (see section  11.3) 

3 In seconds or milliseconds, via check box 
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Figure 24: Event Macros Tab 

 

 

Figure 25: Using the Toggle 1-2-3-4 Behavior 

10 Creating a Macro 

A macro includes a sequence of commands assigned to a selected button on 
the RC device 

These commands can be derived from: 
• Relay Open and Close commands 
• The driver files of the peripheral devices that are to be controlled by the 

RC device 
• IR remote control transmitters, via the IR Learner feature1

To create a sequence of commands: 

 

1. Press a button in the Front Panel Keypad tab to select the button to which you 
want to write the macro. The button turns green: 

                                                        
1 For RC devices that have the IR learner feature 
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Figure 26: Selecting a Button to Write a Macro 

2. Click the New button in the Button Macro area: 

 
Figure 27: Creating a New Command 

3. Select a port1

4. Select the required Vendor, Device and Revision from the appropriate 
dropdown box, and then select a command from the Driver command 
dropdown box and write its description. 
The Command bytes (and the number of bytes in the command) appear in a 
box below the Revision and Driver command dropdown boxes. 

 from the drop-down box (for example, the RS-232_1 Port). The 
default driver appears. 

                                                        
1 This is an example. The RC command area appears different for different ports, as described in section  10.2 
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Figure 28: Selecting the Port 

You can update the default driver for this port by clicking the Update button 
beside the Port default driver box (see section  8) 

5. Click the up or down arrow to save the command to the macro. 
6. Repeat this process to add new commands. Click Duplicate to duplicate the 

command and delete a command by clicking the Delete button. 
7. If required, set a delay time after the command or set the button lighting: 

 
Figure 29: Setting the Delay Time and Button Lighting 
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10.1 Labeling the Buttons 

For your convenience, you can label the buttons in the Front Panel keypad tab 
area, as illustrated in the example in Figure 30. 

 
Figure 30: Labeling the RC Buttons 

To label a button: 
1. Open the Kramer RC Configuration main window. 
2. Select a button. 
3. Type the button text in the Label area: 

 
Figure 31: Typing the Label 
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10.2 Adding Commands to the Macro 

Each room controller includes a different set of commands, as defined in 
Table 1. The following sections describe how to write a new command for the 
different ports. 

10.2.1 A Relay Command – Turn Lights ON  

To write a relay command on an RC button (for example, turn the lights on), 
do the following: 
1. Open the Kramer RC Configuration main window. 
2. Select a button from the RC buttons layout. 

The button turns green. 
3. Click the New button (in the Button Macro area) to add a new command to the 

Button Macro. 
4. In the RC command area, write the command description (for example, Lights 

ON). 
5. Select the Port1

6. Select the relay command (for example, Close). 
 you want to assign (for example, RELAY_1) 

Figure 32 illustrates the RC Command area as it appears after writing the 
command: 

 
Figure 32: Lights ON RC Command 

                                                        
1 When selecting a relay as a port, the Vendor, Device and Revision drop down boxes disappear and the Driver command 

drop down box is replaced with a Relay Command drop down box 
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10.2.2 The Driver Command – Switch a DVD Player to the Projector 

This section applies to Serial (RS-232, RS-485) and ETH commands, as well 
as the VP-23RC (internal) command, specific to the VP-23RC machine. 

To add a Driver command to a macro (for example, to switch the DVD player 
to the projector1

1. Open the Kramer RC Configuration main window. 
), do the following: 

2. Select a button from the RC buttons layout and label it “DVD”. 
3. Click the New button (in the Macro area). 
4. In the RC command area, write the command description (for example, 

Projector  -- Input B (DVD)). 
5. Open the Port drop down box and select the relevant port2

6. Select the Driver command (for example, “switch”) from the drop down box. 

 from the list. 
The default driver associated with this port appears (or you can select a new 
one and then update the port manager). 

The Command Bytes area shows the command string. 

Figure 33 illustrates the Button Macro display box and the RC Command area 
as it appears after writing the driver command: 

                                                        
1 In this example, the projector driver was added manually via the New buttons in the Driver Manager window 

2 Once the port is selected, the default driver details appear 
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Figure 33: Switch a DVD to the Projector Command 
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10.2.3 The IR Command –Audio Follows Video in a Matrix Switcher 

To add an IR command to the macro, do the following: 
1. Open the Kramer RC Configuration window. 
2. Select the RC button to which you want to add the command. 
3. In the Description text box, type the new command’s description (for example, 

Audio Follows Video). 
4. From the Port drop down box, select the desired IR port1

5. From the Command drop down box, select the relevant command (for 
example, AFV). 

 (for example, IR_1). 

Figure 34 shows the IR command setting: 

 
Figure 34: IR Command Setting 

 

                                                        
1 Once the port is selected, the default driver details appear 
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10.2.4 The Self Command 

The self command is used to change the toggle state of another button. The 
example in Figure 35 shows the front panel tab of an RC-8IR device: 

 
Figure 35: Self Command Front Panel Setting 

Button 3 and button 7 are labeled DVD and VCR respectively. Buttons 5 and 
6 are labeled Play and Stop respectively, their behavior is set to 2 toggle states 
and the Automatic Advance box is not checked. 

The Play button macros consist of a: 
• Toggle 1 macro that includes a Play command for the VCR player 
• Toggle 2 macro that includes a Play command for the DVD player 

The Stop button macros consist of a: 
• Toggle 1 macro that includes a Stop command for the VCR player 
• Toggle 2 macro that includes a Stop command for the DVD player 

For both the Play and Stop buttons the Automatic Advance check box must 
NOT be checked. 



KRAMER:  SIMPLE CREATIVE TECHNOLOGY 

Creating a Macro 

 36 

When creating a macro for the DVD button, the self command can change the 
toggle state of the Play and Stop button so that the "Play" and "Stop" buttons 
will transmit an IR signal based on whether the DVD or the VCR are selected. 

To add a self command to the macro, do the following: 
1. Open the Kramer RC Configuration window. 
2. Select the RC button (for example, DVD) to which you want to add the self 

command. 
3. In the Description text box, type the new command’s description (for example, 

DVD Stop). 
4. From the Port drop down box, select the Self port. 
5. From the Command drop down box, select the Toggle 6.2 “Stop” command. 

The Inner command includes all the buttons that are in the Toggle state  

Figure 34 shows the IR command setting: 

 
Figure 36: Self Command Setting 
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10.3 Connecting via the ETHERNET 

You can connect the RC device via the Ethernet, using a crossover cable (see 
section  10.3.1) for direct connection to the PC or a straight through cable (see 
section  10.3.2) for connection via a network hub or network router. 

10.3.1 Connecting the ETHERNET Port Directly to a PC (Crossover Cable) 

You can connect the Ethernet port of the RC device to the Ethernet port on your 
PC, via a crossover cable with RJ-45 connectors.  

This type of connection is recommended for identification of the factory default  
IP Address of the RC device (192.168.1.39) during the initial configuration 

After connecting the Ethernet port, configure your PC as follows: 
1. Click to open your Network Connections or right-click the My Network Places 

icon on your desktop. 
2. Select Properties. 
3. Right-click Local Area Connection Properties. 
4. Select Properties. 

The Local Area Connection Properties window appears (see Figure 37). 

 
Figure 37: Local Area Connection Properties Window 

5. Select the Internet Protocol (TCP/IP) and click the Properties Button (see 
Figure 37). 

6. Select Use the following IP Address, and fill in the details as shown in  
Figure 38. 
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7. Click OK. 

 
Figure 38: Internet Protocol (TCP/IP) Properties Window 

8. Connect the power to your RC controller. 
The front panel buttons on the RC illuminate in order, one after the other. 
If the buttons do not respond, check that the power cable is connected correctly 
at both sides and that the PROGRAM DIP-switch on the rear panel is OFF. 

9. Connect the Ethernet crossover cable to your PC and to the RC. Check that the 
LEDs on the Ethernet port blink, indicating an active connection. 

If an active connection is not established, disconnect the power and do the 
following: 
1. Click to open your Network Connections or right-click the My Network Places 

icon on your desktop. 
2. Select Properties. 
3. Right-click Local Area Connection Properties. 
4. Select Properties. 

The Local Area Connection Properties window appears (see Figure 37). 
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Figure 39: Local Area Connection Properties Window 

5. Click the Configure… button and select the Advanced tab: 

 
Figure 40: The Advanced Tab 

6. Under Property, select “Link Speed & Duplex1

7. If the connection speed (appearing under Value) is set to Auto Detect, change it 
to a manual value of, for example, “100Mb Full Duplex” (or less), as illustrated 
in 

”. 

Figure 41.  
The Network Connection Properties window appears; the available options 
depend on the installed network adapter 

                                                        
1 The name may vary depending on the network adapter 
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Figure 41: Selecting Manual Link Speed 

8. Click OK. 
9. Reconnect the power to your RC controller, and check that the buttons now 

illuminate in order. 
10. Connect the Ethernet crossover cable to your PC and to the RC. Check that the 

LEDs on the Ethernet port blink, indicating an active connection. 

10.3.2 Connecting the ETHERNET Port via a Network Hub (Straight-Through 
Cable) 

You can connect the Ethernet port of the RC device to the Ethernet port on a 
network hub or network router, via a straight-through cable with RJ-45 
connectors. 
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11 The Kramer RC Configuration Menus 

This section describes the Kramer RC Configuration menus. 

11.1 The File Menu 

Figure 4  illustrates the File menu and 2 Table  defines it: 6

 
Figure 42: The File Menu 

Table 6: File Menu Features 

Menu Command Function 
New Configuration Click to create a new 

device configuration1

Save Configuration… 
 

Click to save the current 
configuration 

Load Configuration… Click to load a saved 
configuration 

Driver Manager… Click to open the Driver 
Manager window (see 
section  5.2) 

Change Working 
Directory… 

Click to change the 
working directory2

Exit 
 

Click to exit the program 

  

11.2 The Edit Menu 

Figure 4  illustrates the Edit menu and 3 Table  defines it: 7

 
Figure 43: The Edit Menu 

Table 7: Edit Menu Features 

Menu Command Function 
Copy Macro Click to copy a button 

macro command sequence 
Paste Macro Click to paste a button 

macro command sequence 
Clear Macro Click to clear the Macro-

commands sequence box 
Clear Button Labels Click to clear all the button 

labels 

  

 
 

                                                        
1 This will discard the active configuration 

2 The working directory can be changed at any time 
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11.3 The Configuration Menu 

Figure 4  illustrates the Configuration menu and 4 Table  defines it: 8

 
Figure 44: The Configuration Menu 

Table 8: Configuration Menu Features 

Menu Command Function 
Port Manager Lists the ports names, 

description, settings and drivers 
(see section  8) 

Show Delay Check to show in RC main 
configuration window  

Show Button 
Lighting 

Check to show in RC main 
configuration window 

Show Response 
Querying 

Check to show in RC main 
configuration window 

  

11.4 The Device Menu 

Figure 4  illustrates the Device menu and 5 Table  defines it: 9

 
Figure 45: The Device Menu 

Table 9: Device Menu Features 

Menu Command Function 
Discover… Click to open the Device 

Selection window and search for 
connected devices (see section 
 11.4.1) 

Connect… Click to connect via an IP 
number or serial port 

Disconnect Click to disconnect the device 
Properties…1 Click to show the device 

properties dialog 
 

Write Configuration1 Writes the configuration to the 
device 

Read Configuration1 Reads the configuration from 
the device 

Upgrade Applet1 Upload a Java applet 
Lock Panel1 Click to lock the front panel 

buttons on the device 
Unlock Panel1 Click to unlock the front panel 

buttons of the device 
  

 
 
 
 
 

                                                        
1 Active only when a device is connected via the Ethernet 
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11.4.1 The Discover Command 

The Device Selection dialog box detects RC devices via the Ethernet. 

To discover any connected devices, do the following: 
1. Open the Device menu and click Discover1. 

The Device Selection window opens (see Figure 46). 
2. The Device Selection window lists the device found, and its IP number.  

Select the device and then click OK. 

 
Figure 46: Device Selection Dialog box 

Table 10: Device Selection Dialog Box 

Feature Function 
MAX. timeout 
Text Box 

Set time out for searching 
devices2

Selected Device 
Area 

 
Displays Name of the selected 
RC device, its IP Address, 
Type and firmware version 

Refresh Button Click to refresh Discover list 
Identify Button Click to identify the connected RC 

device3

 
 

 
  
 

If the Discover command failed to detect any connected devices, do 
the following: 
• Make sure that the subnet mask definition of the device is correct  

• If a Firewall is installed, it is probably blocking the communication. 
To overcome this problem, in the Firewall definitions, open the 2243 
and 2244 ports used for the UDP protocol 

• It is recommended to seek assistance from the Network 
Administrator 

 

                                                        
1 To automatically search for devices 

2 You can set the timeout according to your needs. For example, if the connected device cannot be discovered, you may 

increase the timeout value. If the device can still not be detected, it is probably due to a communication problem 

3 The buttons on the device that was detected flash twice 
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11.5 The Help Menu 

Figure 4  illustrates the Help menu and 7 Table 1  defines it: 1

 
Figure 47: The Help Menu 

Table 11: Help Menu Features 

Menu Command Function 
Check for updates Search the Kramer 

Electronics Web site for 
software updates 

About Kramer RC 
Configuration 

Shows the current software 
version 
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12 Assigning the Macros to the RC Device 

Once your configuration is ready, you can save it by clicking the save 
configuration button in the File menu and then connecting the RC device to the 
PC (see section  6) and writing the configuration to the device. 

12.1 Saving a Configuration 

To save a configuration, do the following: 
1. Click the ”Read Configuration” button to download the configuration of the 

RC device. 
2. From the File menu, select Save Configuration…. 

The Save As window opens (see Figure 48). 
3. Save the configuration. 

  
Figure 48: Saving a Configuration 

12.2 Writing a Configuration to the RC Device 

1. Connect the RC device to the PC (see section  6): 
2. From the File menu, select Load Configuration…. 
3. Open the RC-1 device configuration file. 
4. Click the ”Write Configuration” button. 

The configuration is assigned to the RC Device. 
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13 Installation of the RC System 

After connecting the RC system components, connect a 12V DC power 
supply to the terminal block connector, taking care that polarity is correct. 
To achieve the best performance: 
• Connect only good quality connection cables, thus avoiding 

interference, deterioration in signal quality due to poor matching, 
and elevated noise- levels (often associated with low quality cables) 

• Avoid interference from neighboring electrical appliances and position the 
RC system away from moisture, excessive sunlight and dust 

13.1 Connecting the RS-232 Port 

The RS-232 9-pin D-sub connector port is defined in Figure 49 and Table 12: 

RS-232 PINOUT

Rx

GND

1
2
3
4
5

6
7
8
9

Tx

 
Figure 49: RS-232 PINOUT Connection 

Table 12: RS-232 PINOUT Connection 

Connect this PIN on the 
Terminal Block Connector: 

To this PIN on the 9-PIN 
D-SUB  Connector 

Tx PIN 2 
Rx PIN 3 
GND PIN 5 

 

Figure 50 shows how to 
connect the RS-232 
terminal block connector 
port for bidirectional 
communications. 

Peripheral Device
RS-232 Port

G  Rx  Tx

 
Figure 50: RS-232 Port Wiring 
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13.2 Connecting the RS-485 Port 

Figure 51 shows how to connect the RS-485 terminal block connector 

 
Figure 51: RS-485 Port Wiring 

13.3 Connecting the Relays 

Figure 52 shows how to connect the relays. 

To Room
Items

 
Figure 52: Relay Wiring 

On each 3-pole terminal block connector, connect either: C to NO, or C to 
NC. Table 13 defines the Relay PINOUT:  

Table 13: Relay PINOUT 

RELAY PINOUT 
C Common 
NO Normally Open (relay is open by default and closes for 

activation) 
NC Normally Closed (relay is closed by default and opens for 

activation) 
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13.4 Connecting the IR Emitter 

Figure 53 shows how to connect the IR emitter1. The white striped side 
connects to IR OUT, the black side connects to the Ground, and the LED 
Emitter Shell is affixed to the IR sensor window with the adhesive layer. 

 
Figure 53: IR Emitter Wiring 

NOTE: The dual IR emitter emits a weaker IR signal that may not be detected 
by some devices 

13.5 Inserting the Button Labels 

To insert a button label, do the following: 
1. Unscrew the faceplate attachment screws, using a screwdriver. 
2. Gently remove the transparent button cap with your fingers. 
3. Insert the label under the button cap. 
4. Replace the button cap with the label onto button base. 

14 Ethernet Flash Memory Upgrade 

You can find the latest firmware version for the firmware upgrade on our Web 
site at http://www.kramerelectronics.com. 

The Flash memory upgrade instructions for each machine are available in 
each product's user manual. 

 
 
 
 
 

                                                        
1 The Kramer 3.5mm to IR Emitter Control Cable (C-A35/IRE-10) 

http://www.kramerelectronics.com/�
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14.1 Uploading the Applet1

After upgrading a unit's firmware, the Java Applet has to be manually  
re-uploaded to preserve remote access via a Web-browser. The Java Applet 
data file can be found on the disc or on our Web site at 

 

http://www.kramerelectronics.com. 

To upload the applet to the unit via the Kramer RC Configuration: 

Follow these steps to install the Web Applet: 
1. Connect RC device to your PC through computer networking: 
2. Start RC Configuration Software and connect to the RC device (see section 

 11.4.1). 
3. In the Device menu select Upgrade Applet option and browse to the MC.dat 

file included in the package: 

 
4. Wait until uploading is complete2

5. Click OK. 
 and the success message appears.  

 
 
 
 
 
 
                                                        
1 This section is relevant only for units with an Ethernet connector 

2 The product's built-in Java Applet may take a few minutes to load 

http://www.kramerelectronics.com/�
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15 The UDP Protocol 

The RC device has a UDP protocol for some basic functions. Send the 
commands to the IP address of the RC device to UDP port 2243. Please note 
that all commands consist of bytes in hex format. 

 

Legend: 

[ID*] = the ID of the button to activate 

[LIGHT*] = light status, [00] = OFF, [01] = ON 

 

Remote button activation – emulates a button push: 

[00] [01] [00] [04] [ID*] [00] [00] 

Response: 

"OK TEST" upon receiving the command 

"OK MACRO" when the macro has finished 

Get button light status – tells whether the backlight of a button is on or off: 

[00] [00] [00] [0E] [ID*] [00] [00] 

Response: 

[00] [00] [00] [0E] [ID*] [00] [01] [LIGHT*] 

Set button light status – turns on or off the backlight of a button: 

[00] [01] [00] [0E] [ID*] [00] [01] [LIGHT*] 
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